
About the database structure navigation and management utility

DTM Schema Inspector is a set of database schema management tools that let you work with
database schemas more effectively. The Schema Inspector allows you to:

 access database schema information for various data sources simultaneously.
 create, save, load and view schema snapshots.
 view and export texts for database objects.
 view properties of the objects.
 observe and export tables' and views' data (text, SQL, XML, HTML, Microsoft Excel).
 export database schema as a set of the SQL statements for the data source or selected

database.
 search database objects by name, type, database name and objects text.
 filtering options for database object trees (by name, type, database name or objects

text).
 drop and rename database objects, enable/disable triggers.
 view access rights for tables, columns and views.

The software product allows the user to view lists of

 tables with indexes, primary and foreign keys.
 access rights for tables and columns.
 system tables.
 views or queries.
 synonyms.
 users (for MS SQL, Sybase and Oracle data sources).
 databases (for MS SQL and Sybase data sources).
 stored procedures
 extended stored procedures (for MS SQL Server).
 triggers (MS SQL, Sybase, Oracle, and Interbase).
 data types.
 defaults (for MS SQL and Sybase).
 rules (for MS SQL and Sybase data sources).
 roles and server roles (for MS SQL Server).
 type (insert, update, etc) and status (enabled or disabled) of the triggers (MS SQL Server

and Oracle).
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Database Connection

Quick Start: how to connect?

There are five ways to connect to a database:

1. Direct connection 
2. Connection to desktop files 
3. Data source with ODBC, IDAPI or Oracle Call Interface (OCI) 
4. DSN File connection 
5. OLE DB connection 

In all modes the "Test" and "Information" buttons, as well as tools for working with
connection profiles are available. "Test" button allows you to check information you entered 
and/or data source (or alias) configuration. 

See also:

 Troubleshooting guide 
 Connection information 
 Connection profiles 
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Connection Quick Start Guide

Database How to connect

MS SQL Server Enter or select server name at the direct connection panel

Local SQL Server 
Express

Enter .\SQLEXPRESS as server name at the direct connection 
panel

Oracle
1) Switch to data sources mode
2) select OCI as "Interface"
3) select your service name from data source drop-down menu

DB2 Use direct connection panel or 
Use predefined ODBC DSN for custom connection settings

MySQL
Install ODBC driver for MySQL from www.mysql.org
Use direct connection panel or
Use predefined ODBC DSN for custom connection settings

PostgreSQL Use direct connection panel or 
Use predefined ODBC DSN for custom connection settings

Interbase/Firebird
Install ODBC driver
Use direct connection panel or
Use predefined ODBC DSN for custom connection settings

Microsoft Access 1) Switch to "Desktop File" panel
2) Select "Access" as file type, enter or select file name

Microsoft Excel 1) Switch to "Desktop File" panel
2) Select "Excel" as file type, enter or select file name

Another database

1) Install ODBC driver for your database system
2) Create ODBC data source name using Windows ODBC 
Administrator
3) Switch to data sources mode
4) select your data source from drop down menu
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Direct Database Connection

Direct Connection

The direct connection method allows you to connect to most popular databases (MS SQL 
Server, Oracle, Interbase/Firebird, MySQL, PostgreSQL and DB2). 
Enter the server name and the database name, if required. The user name and password
are optional. Their necessity depends on the settings of your database. The owner name
(schema) is optional too. The list of visible database objects depends on the choice of the
owner. If the owner is empty, you will access all objects. There is important that
schema/owner name is case sensitive. 
If you do not find the required database type in the list or cannot connect directly, use a
connection through the predefined data source. If DBMS is in the list, but unavailable, it
means that either the required ODBC driver is not installed or it is not configured properly.  
During its use, the program stores the entered values of server names, users and owners.
You can select a value from the stored list using the corresponding combo box. For some
DBMS types (MS SQL, for example), the program can fill the list of available databases.
Use the button with two arrows for this purpose. 

DBMS-specific connection options 

Microsoft SQL Server

 "(local)", empty or "." server name means local server 
 use <server name>\<instance name> syntax to identify instance. Example: 

.\SQLEXPRESS means SQL Express at the local system 

Oracle

Use connect string for the Oracle Server that you want to access as a Server name.

Important: it is strongly recommended to use native Oracle Call Interface (OCI) instead of
direct connection.

Interbase and Firebird

Examples: 

 Server: localhost and Database c:\interbase\myDb.fdb - connect to specified DB on 
local system.

 Server: 172.17.2.10/3051 and Database /usr/local/db/myDb.fdb - connect to 
specified server with alternate port 3051 on remote system 172.17.2.10 

MySQL
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 Use localhost for local MySQL 
 example.com;port=3306 means MySQL at example.com on 3306 port 

DB2

ServerName;port=5000;protocol=TCPIP as a server name means connect to 
ServerName, use 5000 port and TCP/IP protocol. 

PostgreSQL

ServerName as a server name means connect to ServerName, use 5432 port and TCP/IP 
protocol. Database name is required. localhost as a server name is acceptable. To specify 
custom port you should add ";port=NNNN" string to server name.
server_name_or_ip-address;port=5432;DATABASE=dbname 
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Desktop File Connection

Desktop Files

The second way is designed for connecting to desktop data files. Select the required format 
and specify the file name or the directory where the data is located. Other parameters are
optional. 
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Data Sources

Predefined data sources: ODBC, IDAPI, Oracle Call Interface

A connection with the use of a data source is the most universal. You can select ODBC,
IDAPI or OCI (if installed) interface and the preconfigured data source name. In this case,
other options are similar to those of a direct connection. The "Manage" button allows you
to get access to the external configuration utility if it is available. When you want to
access the tables belonging to the single database schema (or owner), you should fill the
"owner" entry; otherwise, all tables will be accessed. 
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File Data Source Name

DSN File

The fourth way is using a DSN file. For this case, just select the file name with DSN
definition. 
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OLE DB Connection

OLE DB connection

Use 'Configure' button to specify connection information. Password and owner fields are
optional. 
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Connection Profiles

Connection profile helps you to save information about your connection (interface, data
source or alias name, user name (login), password and database name, etc) and get access 
it by the one click. 

Please fill connection properties and press "Add as new" to add a new profile. To modify 
the profile you should select it from the list at the top of the window, modify properties
and press "Update". "Delete" button works when you select the profile to be deleted in the 
list.

"Save" and "Load" buttons allow you to save profiles to the disk file or load them. The 
"Export one" button helps to save single currently selected profile.

Important: all profiles are shared between all installed DTM soft products. That means 
once created profile can be used with any tool. At the other side if you remove the profile 
from the list you can't use it with DTM soft's products anymore.
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Connection Information

The program provides detailed database, connection and driver information and properties. 
The "Information" button at the connect window allows you to view it. 
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Database Connection Troubleshooting Guide

Troubleshooting Guide

Problem description Possible reason Solutions

Required database type not 
present in the list at Direct
Connection and Desktop 
Connection pages

 

Switch to "data source" 
connection mode and select data 
source from the list or configure 
new one with "Manage" button.

Required format is in the 
direct connection list, but not
available (disabled).

ODBC driver for your 
database does not
installed or not
configured properly.

Install required driver. If it is 
already present in the system, 
please contact our support staff.

Errors during direct 
connection. Compatibility problems. Try to create data source for 

your database connection.

Login error for correct user 
name and password.

Read-only desktop data 
file.

Try to change file mode to 'read 
and write'.

I can't see relationships, 
defaults, etc in my Access 
Database.

Access interface.

Try to switch on "Use Microsoft 
Jet" check box at the "Desktop 
File" page of the Connect 
Window.
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Program settings

The program has some settings and options to make your work more comfortable. Don't 
forget to press "Ok" button in "Settings" dialog to save the settings you chose.

The most important settings are:

1. Preview binary large objects (BLOBs) as text (in hexadecimal mode by default). 
2. "View NULL as <NULL>" option allows selecting of the visualization mode for NULL 

values between displaying the special sign <NULL> and just emptying the cell. 
3. You can turn the syntax highlighting for keywords, comments and strings (constants) 

on and off. 
4. Change the size and the font face for text view window as well as "Tab" size.

 

The group of options named "Schema" lets you specify types of objects you can view in the 
object tree. By default, "access rights", "server roles" and "extended stored procedures" are 
turned off.
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Database objects filters

The schema browser allows you to set filters for the objects displayed in a tree-like
manner. Filters can have the same parameters as the search.

Be careful with filters, you can set such a filter that there won't be any objects displayed. 
Should this happen, exit the program and restart it - the product does not save filters upon 
exiting.

Note: the filter is not applicable to collections (node items) and databases (Microsoft SQL
Server only).
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Search for database object

The "search database object" feature helps you to find any object in the database. You
may use following search criteria or combination thereof:

 Object name or part of the name. 
 A database that contains the object (only for MS SQL and SYBASE databases). 
 Object type same as TABLE, VIEW, PROCEDURE, etc. 
 Text fragment of the object definition. For example, a text of the stored procedure . 

Important: searching through the object text can considerably slow down the performance 
because the program extracts all texts of all the scanned objects from the database.

Please remember, pressing Ctrl-F will help you to access the search dialog faster. Press F3 
to run next search with current criteria.

"Search" dialog saves the position of the window and entered data either for the current 
session or between sessions.
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Database objects tree

The object tree in the left part of the window can contain any number of database 
schemas. Use the "Add data source" button (or press Ctrl+A) on the program toolbar or 
select the corresponding item from the File menu to add a new database schema to the 
tree. You can remove schemata that you do not need any more from the tree. To do that, 
select the root of the schema you want to remove in the tree and select the "Remove from 
tree" item (or press Ctrl+D) from the File menu.

You can refresh the tree content by using the corresponding button on the toolbar. 
Remember that the schema gets to the end of the tree when the tree is refreshed.

The program automatically saves the connection information (the interface type, the data 
source name, the user name (login) and password) for data sources, if you set the option 
"Save/restore active connections" in the Settings window. In that case, when the program 
is launched, it automatically restores the connection with the specified data sources.

See also: operations
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Operations with objects

There is a picture of local menu accessed by the right click on the tree item.

Using this menu you can:

 Copy name of the selected item onto the clipboard. 
 Copy text of the selected item onto the clipboard.
 Save the text of the selected item to SQL file.

You can view the content of such objects as views (queries) and tables using "Data" tab. 
The program allows you to export the data into various formats (text, SQL, HTML, XML, RTF 
or Microsoft Excel) from that data grid.
Placing the mouse cursor over the column header will tell You the type of data stored in 
this field.

There is a picture of context menu accessed by the right click inside the data grid window.

Moreover, you can use "Operations" tab at the right pane of the program window. Using it 
you can:

 drop the current database item 
 rename object 
 enable or disable trigger (for Microsoft SQL Server and Oracle data sources) 

The program can remove many object types (e.g.: tables, views or triggers) by generating 
the corresponding DROP statement.
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You can rename few types of the objects for MS SQL Server and Oracle Server.

You can enable and disable triggers for Microsoft SQL Server and Oracle Server.

See also: "objects tree"

© Copyright 2000-2020 DTM soft.



Export schema

The software product allows the user to export currently selected database schema to a set 
of SQL statements. You can use the corresponding toolbar button or "Export schema" item 
in Tools menu of the DTM Schema Inspector.

Also, you can export table rows as a set of the INSERT statements. See "export" menu 
item in the data grid context menu (right button mouse click).
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Technical information, System requirements

DTM Schema Inspector is a true Win32 application, known to be compatible with the
following operation systems:

 Windows XP, 32-bit version of DTM Schema Inspector only  
 Windows 2003 and 2008 Server family 
 Windows Vista
 Windows 7

You'll need 32 -bit ODBC, OLE DB, IDAPI or OCI (Oracle Call Interface) interface to manage 
schema, view table's data and execute SQL statements.

Hardware requirements

 RAM: 128 MB 
 Hard Disk: at least 5 MB of free space required for installation
 Display: 800 x 600 or higher resolution, 256 colors 

Compatibility note

Considering the fact that there may be some misinterpretations of the unified DBMS 
interface specification, the problems may arise with some exotic ODBC or IDAPI drivers. For 
example, missing data types, garbled non-standard data type support etc. Please contact 
our technical support when problems of this nature arise. When you contact technical 
support, you should be prepared to provide the following information:

 DTM Schema Inspector version (you can find this information from About menu item of 
Help menu). 

 Type and version of the ODBC (or IDAPI) driver. 
 DBMS version and operating system version (including service pack version, if 

applicable). 
 DTM Schema Inspector Log file. 
 A description of what you do before the problem occurs. 
 Error messages you see when the problem occurs. 
 Your name, company name and how to contact you. 

Limitations

1. Maximum column width in the results view is 512 characters. 
2. Export for large binary objects is not supported. 
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SQL Console

The tool has a special window where you can specify and execute any SQL statements. You 
can copy the results of executing a statement onto the clipboard or export it into various 
formats like text, SQL, HTML, XML or Microsoft Excel. Placing the mouse cursor over the 
column header will show the type of data stored in this field.

Important: the SQL console does not show any warning before data deletion or modifying.

Note: SQL console shows only begins of large strings. Typically you can view up to 512 first 
symbols.

Menu item "Load" allows you to read SQL script from the external file.

There is a picture of local menu accessed by the right click inside the results window.
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Product FAQ, program tips

Q: What is the easiest way to place table data into MS Excel spreadsheet format?

A: Right click one the window with the table's data and select "Export". Select "Excel" as 
your export format.

Q: Are there easy ways to publish the table or view data on the Web?

A: Use HTML export feature. Right click on the window with the rows and select "Export". 
The program saves data in the very basic format, so we recommend you to employ some 
more powerful HTML authoring tool to edit the data afterwards.

Tips. Did you know...

You can use right mouse button to get access to the context menu in schema tree, data 
view, and other windows.

You can select rows, columns or set of cells in the results grid using left mouse button and
drag.

You can view Binary Large Objects as binary or as hexadecimal. View "Settings" for more 
details...

The program can visualize NULL data values as empty strings or as "NULL" strings. See 
program options for detailed information...
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Shortcuts / Hot keys

Hot Keys

Hotkey Function or Option

Ctrl+A Add data source to the tree

Ctrl+D Disconnect from data source

Ctrl+E Editor SQL script for current object

Ctrl+F Find object

Ctrl+L View log file

Ctrl+R Rescan database schema

Ctrl+S Open SQL console

F1 Open help

F3 Find next object

F5 Run DTM Data Editor for currently selected connection

F7 Open settings window

F8 Apply object filter
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Troubleshooting guide

Q: I cannot run the program and there is no error message. What should I do?

A: Check if you have all required files installed. Try to reinstall the program.

Q: The program detected the installed OCI, but displays an empty list of data sources. 
What should I do?

A: Perhaps, the file tnsnames.ora was not found. Either put that file in one of the folders
given below or contact the technical support:
%ORACLE_HOME%\net80\admin\tnsnames.ora or
%ORACLE_HOME%\network\admin\tnsnames.ora

If you have encountered some unusual problem that is not listed here, feel free to contact 
our technical support.
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How can I order DTM Schema Inspector software?

The software is available worldwide via the Internet. Secure online, mail/check and 
corporate purchase order options are available. For detailed information please click 
following link to open order page or copy http://www.sqledit.com/si/order.html to your web 
browser. 

If you have any payment questions feel free to contact the DTM Schema Inspector technical 
support at support@sqledit.com

© Copyright 1998-2020 DTM soft.
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Database utilities by DTM soft

DTM SQL Editor (www.sqledit.com/editor) is a set of powerful database management tools 
that allow you to achieve two goals - to have unified access to different types of
databases and to have a set of solutions that makes processing your data easy. DTM SQL 
Editor gives database users, developers and administrators an ability to access different 
databases, whether desktop or client-server ones (provided you have ODBC driver 
installed). This is very convenient, since most organizations use several different types of
databases installed and each stores data in different formats and with varying parameters. 
Having a program that can get data from various sources is often essential. Furthermore, in 
addition to letting you quickly switch between different data sources, DTM SQL Editor lets 
you see database schema and results of the query execution.

DTM Migration Kit (www.sqledit.com/mk) is a powerful yet simple data migration tool that 
comes in handy if you run multiple databases. Use it to import, export or migrate data 
between different data sources (ODBC, OLE DB, or Oracle Call Interface supported). The 
program is fully automatic and supports all popular database formats. Simple visual 
interface lets you set own transformation and flow control rules to give you added 
flexibility.

DTM Schema Reporter (www.sqledit.com/sr) is a reporting tool for database schema. The 
program creates reports in RTF, HTML, XML or plain text formats and supports all common 
database interfaces - ODBC, OLE DB, or even Oracle Call Interface. This utility helps 
technical writers and database administrators create a report of any complexity level within 
seconds. Also, you can alter table order in the report and manually add annotations to the 
individual tables.

DTM Data Generator (www.sqledit.com/dg) is a simple, powerful and fully customizable 
utility that generates data for database testing purposes. Currently, database developers
and administrators often have to spend hours of dull work to create test data sets before 
examining database performance. This tool makes all this unnecessary by automatically 
creating database objects AND sets of SQL statements, if necessary.

DTM Data Editor (www.sqledit.com/de) is a data viewer and editor for database 
professionals who are tired of wasting their time on mundane tasks. The program uses 
form-based interface and works with any ODBC data source. SQL statements are generated 
automatically and can by modified later. For data that has foreign key - primary key 
relation, there are options to enter values manually or select them from a list, which is 
much faster.

DTM DB Stress (www.sqledit.com/stress) is a utility for stress testing the server parts of
information systems and applications, as well as DBMSs and servers themselves. This tool 
allows you to create and configure a continuous set of requests to the server of the OLAP 
(query execution) and OLTP (adding, modifying and deleting data in the database) types. 
At the same time, the user can flexibly change both the number and the priority of this or 
that type of requests to a database or an application.

DTM Data Modeler (www.sqledit.com/dm) is a CASE tool for database developers that 
supports both forward and reverse engineering. It is an easy-to-use tool allowing you to
work both with logical and physical data models in the form of an entity-relationship
diagram. The product is intended for database architects and developers and works with 
data sources via the ODBC interface, which means compatibility with all modern DBMS. 
Along with basic model properties (sets of entities and relationships between them), the
program allows you to create indexes and triggers on the physical level corresponding to 
the tables of the database that is modeled.

DTM Data Scrubber (www.sqledit.com/scr) is a set of intelligent tools for data verification
(audit) and scrubbing (cleaning). Depending on user-defined rules and data properties, the 
program either creates a report about the actual state of affairs or performs database data 
correction. 
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http://www.sqledit.com/dm
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DTM Data Comparer (www.sqledit.com/dcmp) is a visual tool for data compare and 
synchronization. The program successively views the contents of both tables basing on the 
order of ascending of unique key values and shows differences or creates synchronization 
script. 

DTM Schema Comparer (www.sqledit.com/scmp) is a tool for database schemas comparison 
and synchronization. The comparison process supports tables, views, indexes, triggers and 
stored procedures. The visual representation of database schemas as a tree makes the 
comparison process more comfortable. 

DTM Query Reporter (www.sqledit.com/qr) is a reporting tool for database query. This 
utility helps technical writers, developers and database administrators create a report 
based on database query within seconds. 

DTM Schema Inspector (www.sqledit.com/si) is a database schema browsing and 
management tool that let you work with database schemas more effectively. 

DTM DB Event (www.sqledit.com/event) is a database monitoring and management tool. 
This utility allows the user to define a few situations (events). For each event the user can
define what the program should do if the event is occur. 

DTM Flat File Generator. Easy to use tool that helps any developer or QA engineer to create 
test data file. It supports tab-delimited, CSV, fixed width and custom separated output 
files. The generator has powerful import and export file structure features. 

DTM Test XML Generator. The tool is powerful generator for XML documents with structure 
defined by user and random but realistic data. More than 30 predefined generators with 
powerful pattern engine. The rich import XML structure options are available. 

DTM Data Generator for Excel is a tool for text Excel spreadsheet population. Easy to use
interface based on predefined generators, rich value library and high performance. 

DTM Data Generator for JSON produces JSON files with defined structure in a bulk manner. 
Fast and easy structure editor and smart import options helps the user to generate test set 
in a few clicks only. 

DTM Database Content Analyzer is a statistical tool for database content. It collects a few
dozens of most interesting data: database objects size, value frequency, clusters, etc. This
tool replaces and extends "Statistics" report of obsolete versions DTM Schema Reporter. 
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http://www.sqledit.com/DatabaseAnalyzer
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License Agreement (EULA)

This License Agreement covers all existing versions of DTM Schema Inspector (Software) 
and technical support service (Service). This License Agreement is a legal agreement 
between the end-user (Licensee) and DTM soft (Licensor). 

CAREFULLY READ THE TERMS AND CONDITIONS OF THIS AGREEMENT PRIOR TO USING 
THIS PRODUCT. USE OF ANY PORTION OF THIS PACKAGE INDICATES YOUR AGREEMENT TO 
THE FOLLOWING TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH SUCH TERMS AND 
CONDITIONS, DO NOT INSTALL THE SOFTWARE.

General Information

1. Licensor is exclusive owner of all DTM Schema Inspector copyrights. DTM Schema 
Inspector is protected by copyright laws and international copyright treaties. 

2. Demo version. Anyone may install and use demo version of DTM Schema Inspector for 
evaluation and testing purposes free of charge. 

3. The product is licensed, not sold. I.e. Licensor grants to Licensee non-exclusive, 
perpetual, royalty-free right and license to install, configure, execute and otherwise 
productively use a copy of the Software for the commercial or non-commercial 
purposes, including internal business purposes. Licensee may install and use each 
licensed copy of the Software on a single computer. The primary user of the computer 
on which DTM Schema Inspector is installed may make a second copy for his or her 
exclusive use on a portable computer. 

4. Licensee may not reverse engineer, modify, translate, decompile, or disassemble DTM 
Schema Inspector. The Software is licensed as a single product. Its component parts 
may not be separated for use on more than one computer. 

5. Licensee may not rent, lease, or lend the Software. Also, Licensee may not resell, or 
otherwise transfer for value, the Software. 

6. Without prejudice to any other rights, Licensor may terminate this License Agreement 
if Licensee fail to comply with the terms and conditions of this Agreement. In such 
event, Licensee must destroy all copies of the Software with all of its component
parts. 

7. Licensee may permanently transfer all of rights under this license, provided Licensee 
retain no copies, Licensee transfer all of DTM Schema Inspector (including all 
component parts), and the recipient agrees to the terms of this license. 

8. DTM Schema Inspector IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS 
EXPRESSED OR IMPLIED. LICENSEE USE DTM Schema Inspector AT YOUR OWN RISK. 
IN NO EVENT SHALL EITHER PARTY BE LIABLE FOR DATA LOSS, DAMAGES, LOSS OF 
PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS SOFTWARE. 

Delivery

Licensor delivers the Software electronically over Internet. The delivery includes 
installation/activation key, software, documentation* and additional materials with
installation program*. Licensor confirms that the delivery contains no illicit code or third 
party code.
The customers in North America allowed to request physical delivery on CD for extra fee.

*- the multiplatform edition of the software (if applicable) has online documentation only 
and requires no installation program.

Licensee Data

Licensor understands and acknowledges that Licensee may manage, modify, summarize, 
maintain, create derivative works of, and update pre-existing data and information, and 
generate, manage, modify, summarize, maintain, create derivative works of, and update 
additional data and information using the Software. Licensor acknowledges and agrees that 
all rights in any work product created by Licensee shall be solely owned by Licensee. 
Licensor has no access to mentioned work product without grant by Licensee. Moreover, 

 

 



  

 
 

 

 

 

  

 

Licensor shall not seek access to Licensee personal data.

Functionality

Licensor may remove or change any supplemental or non critical functionality of the 
Software without any notifications. Licensor may change product documentation and project 
file format. If Licensor deletes any key feature or functionality from the Software equal 
solution should be provided to Licensee without additional fee.

Third Party Software and Intellectual Property

Licensor hereby confirms that the Software contains no third party components including 
Open Source code.

Support and Upgrades

During one year after ordering any license of the Software except "Site" and "World" 
licenses, Licensee are entitled to free technical services and support for DTM Schema 
Inspector which is provided by Licensor. During this period, e-mail support is unlimited and 
includes technical and support questions. Also, during one year, Licensee may access to 
free updates to DTM Schema Inspector when and as DTM soft publishes them on 
www.sqledit.com. After end of the described period Licensee may continue to use the 
software product in accordance with the terms of this Agreement except free support and 
upgrades. After end of the free support and updates period (one year), Licensee may 
purchase annual Upgrade and Support subscription. If Licensee has a few licenses, 
Licensee will access to free upgrade and support period and will use subscriptions 
independently.

There are two support service levels: Standard and Premium. By default, the Software 
includes Standard level of the Service. The Premium should be ordered separately. The 
Premium service offers reduced response time and high priority for support requests. The 
technical support response time for Standard level is between 2 and 12 hours except Jun, 
July and August with 2 to 24 hours range. It is available 5 days per week (Monday to 
Friday). For the Premium level it is 2 to 6 hours 7 days per week.

Export Compliance

Licensor hereby confirms that the Software requires no export controls at a level other than 
EAR99/AT.

Price Protection

Licensee who purchases volume license of the Software allowed to order additional copies 
with the same price during following period after initial deal: 3 months for 3 to 5 copies, 6 
months for 6 to 10 copies and 9 months for 11 or more copies.

Trademarks information

DTM Schema Inspector is trademark of DTM soft.

Licensee hereby grants DTM soft a right to use company name or trade names solely in 
connection with the rights granted to DTM soft pursuant to marketing materials and web 
site. If this clause breaches company policy DTM soft is happy to remove it upon request.
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Demo and Full version differences

What differences between the demo and full versions of DTM Schema Inspector?

General functions

 Demo version replaces some objects text to DEMO. 
 Demo version shows only top 6 rows of tables, views and synonyms. 

Supplemental functions

 SQL console partially replaces result values to DEMO string. 

No other demo limitations are present except nag-screen at program shutdown. 
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Program Installation

To run installation program:

 Open the windows Start menu and select "Run" item 
 Select or enter installation file name and path (si.exe or si_d.exe)* and click OK  

* - professional and enterprise editions of the tool may have another suffix.
 

Notes:

 Please be sure that existing version of the tool is not running when you install a new
version. 

 We recommend to uninstalling old version of the DTM Schema Inspector before new 
version installation.

 Installation by administrator for another user is supported for most environments. 
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Uninstall the Software

The Uninstall feature removes all installed DTM Schema Inspector components and all 
records in the Windows registry made by the installation script. You can uninstall this
program by selecting the "DTM Schema Inspector" item in "Add/Remove Programs 
Dialog" in "Control Panel".

Another uninstallation way is to run "unins000.exe" from the product's folder directly.

Important! Uninstall feature of the program does not remove files and objects created by 
users such as configuration files, registry records etc.
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How to upgrade your copy of DTM Schema Inspector?

The user can refer to "Check for Update" features to get information about available 
updates.
Please contact our support staff at support@sqledit.com to upgrade commercial version of 
the tool.

Demo version is available for download free of charge.

When you upgrade your copy of DTM Schema Inspector please send us the following 
information:

 You name, company name and how to contact you 
 Payment information (at least "ORDER No" and "Date") 
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Technical support

If you have some question or unusual problem feel free to contact the DTM Schema 
Inspector technical support at support@sqledit.com 

When you contact technical support, you should be prepared to provide the following 
information: 

 DTM Schema Inspector version (you can find this information from About menu item of 
Help menu). 

 Type and version of the ODBC or IDAPI driver or OLE DB provider. 
 DBMS version and operating system version (including service pack version, if 

applicable). 
 DTM Schema Inspector Log file. 
 A description of what you do before the problem occurs. 
 Error messages you see when the problem occurs. 
 Your name, company name and how to contact you. 

See Also: log file
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SQL Syntax Mapping Function

There are legacy or custom ODBC drivers with non-standard SQL syntax. Our software 
supports syntax mapping for ODBC connections. This function allows users to replace some 
SQL keywords to another.

For example, your data source requires QUIRY keyword instead of standard SELECT.

The syntax mapping uses text file with predefined name "syntax.map". It should be located 
in the same directory as the software binary files (executable and DLLs).

It contains one line per map*:
 

SELECT=QUERY

* - ';' at the begin of the line means comment, extra spaces about '=' are not acceptable.
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Trademark Information

Microsoft Excel, Microsoft SQL Server and Microsoft Windows are trademarks of Microsoft 
Corp.

Oracle is a registered trademark of Oracle Corp.

PostgreSQL is copyrighted by PostgreSQL Global Development Group.

Borland Interbase is a registered trademark of Borland Software Corp.
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Glossary

Database catalog - The collection of system tables, tables that store metadata about that
specific database.

Database record - one row in a table (table can be a result of SQL-query). 

Database schema - logically connected, usually owner-based, set of DBMS objects (tables,
views, procedures etc).

DBMS - database management system. 

DBMS connection - the fact that both client and DBMS server have signed a contract and 
ready to query and data communications.

Drag-n-drop - the file manipulation technique when the mouse is used to move the file
from the place of storage to the program, which performs processing.

SQL language - the declarative language used to manipulate the data and its' structure in 
the modern DBMS and their client applications.

IDAPI - Integrated Database Application Program Interface, unified DBMS access interface. 

OCI - Oracle Call Interface, access interface for Oracle Server. 

ODBC - Open Database Connectivity, unified DBMS access interface. 

Metadata - information about data. See also: database schema 

SQL statement - single SQL operator having the complete role in a data manipulation 
script.

SQL-server - program or program complex, which is able to execute the SQL-queries. 
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Clipboard support, export features

Export results of Query Execution

Types of export:

 text file with separators or with fixed columns width. 
 HTML file 
 XML document 
 RTF document 
 set of SQL statements (INSERT or UPDATE) 
 direct to Microsoft® Excel (installed Microsoft Excel required) 

Warning! Export for long binary data types (also known as BLOBs) is not supported.

Clipboard support

 Copy selected text onto Clipboard Ctrl-Ins, Ctrl-C
 Cut selected onto Clipboard Shift-Del, Ctrl-X
 Insert text from clipboard into cursor position Shift-Ins, Ctrl-V
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Log File

Log file

When running the program, you have to select one of menu items from "Tools->Log file" in 
order to view or truncate your Log file. The log file contains the detailed description of any 
errors and other events that occurred while processing script. 

Default log file location is product's directory and the name is ERROR.LOG. When the user 
has no enough permissions DTM Schema Inspector saves log to typical path like 
C:\Documents and Settings\<username>\Application Data\si.log or 
C:\Users\<username>\AppData\Roaming\si.log

The log file is a text file that contains three type of records:

1. The software product identification block: product name version and operating system 
information. 

2. Error records: wrong SQL statements, exceptions, etc. 
3. Notification and statistics.
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